T

ether Tools and the American Society of Media Photographers (ASMP) have come together to
create the Ultimate Tethering Guide out of a shared commitment to providing the creative community with the most valuable and useful resources that support the professional practice of still and
motion photography.
This Guide details the benefits of tethering as well as the best gear and software to use to maximize your
results.
We touch on topics like how to set up your workflow, which tethering cables are best for your specific camera model, options for wireless tethering, setting up file management systems, backing up your
work, and workflow security. And that’s just the beginning!
Throughout the guide, we’ll also direct you to many more great resources for staying on top of the latest
advancements in workflow technology.
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ABOUT TETHER TOOLS

ABOUT ASMP

Tether Tools® is a design and manufacturing company providing innovative custom photography
equipment and accessories for in studio and on
location photo and video shoots. Tether Tools is
committed to providing the highest quality tethering and workstation solutions for creatives.
Connect with Tether Tools directly at www.teth-

The American Society of Media Photographers
(ASMP) is the premier trade association for the
world’s most respected still and motion photographers. ASMP is the leader in promoting photographers’ rights, providing education in better business practices, producing business publications
for photographers, and helping to connect purchasers with professional photographers. Founded in 1944, ASMP has more than 6,500 members
and 39 chapters. In addition to a wide range of
discounts and benefits, ASMP members gain the
support of an international community of peers
and a fearless advocate championing their interests in Congress, contracts and the courts.

ertools.com

CONNECT WITH TETHER TOOLS
Tether Talk: The go-to online resource for teth-

ered photography. This blog offers knowledgeable
insight on the latest gear and software, while also
connecting you with top industry professionals
for advice on everything from photography workflow to marketing and sales tips.
Tether Tools Newsletter: Stay connected with our

CONNECT WITH ASMP
ASMP Resources: ASMP offers invaluable online
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monthly newsletter and be the first to know
about new product releases, deals, special events
and more.

resources to help you master the business side of
the business. Access timely webinars, tutorials,
guides and more.
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Facebook: Join 23,000+ other professional photog-

Strictly Business Blog: One of the most widely read

CHAPTER 8 - Backing up

raphers for an interactive online experience that
presents the latest industry news, contests, and
behind-the-scenes sneak peeks.

blogs in the industry, ASMP’s Strictly Business
blog features posts by industry insiders, legal advisors, and technical experts.

Twitter: Real-time conversations with the Tether

Facebook & Twitter Follow ASMP on social media

Tools team and top photographers spanning almost every industry imaginable!

for news, inspiration and more.

Instagram: The best place to catch a behind-the-

online through the ASMP community.

scenes glimpse of tethered workflow from photographers around the globe.

Community: Connect with members locally and
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INTRODUCTION TO TETHERING

T

here’s a lot happening on the average photo shoot. From models and assistants to
props and gear, it’s often organized chaos. When
you’ve got so many moving parts, one of the most
important things you can do for your work (and
sanity!) is to set up an archival tethering system.
In this guide, we’ll dive deep into this topic and
provide you with critical tools for your photography career. Let’s start with the basics.

WHAT IS TETHERING?
Tethering is the connecting of a single device to
another device. The term tethering encompasses
the actual connectivity of digital devices as well
as the integration and mounting of these devices.
In the context of photo and video, both wired and
wireless solutions may be used to transfer information (images, video) from your camera to another device.

WHAT IS TETHERED PHOTOGRAPHY?
Images captured using a tethered photography
workflow get saved directly onto your computer’s
hard drive in the folder of your choice. Tethering
software then displays the images on the larger
computer or tablet screen as they are captured so
you can see them clearly. In some instances, what
we call tethering is sometimes referred to as Direct or Instant Image Transfer – this is how you
will often find it listed in camera and software
manuals.

WHAT IS ARCHIVAL TETHERING?
Archival tethering adds an archival backup system for your images into your tethering workflow. Tethered photography allows you to send
copies to your computer, an external hard drive,
or even your tablet or smartphone. When you set
up an archival tethering system, every capture
from every tethered shoot is automatically saved,
secured, named and backed-up. Managing and organizing your photos as they’re captured, lets you
spend more time shooting and less time filing.
Plus you’ll be able to find specific photos you’ve
already taken quickly and easily.

WHY IS IT IMPORTANT?
Tethering helps you get the perfect photo in fewer shots. Viewing images on a larger screen is a
great way for you and your clients to spot issues
with focus, lighting, posing or composition. You’ll
spend less time editing and your clients can let you
know the moment you’ve captured the shot they
are looking for. From shoot to publishing, archival
tethering speeds up the process in a major way.

BENEFITS TO SHOOTING TETHERED
• View images on a large monitor as you
shoot
• Instantly see images at full resolution
• Check critical focus, composition, styling
• Adjust lighting and camera settings more
quickly and easily
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• Control camera settings and remote trigger
from connected device
• Share images with art director/client on
site or remotely
• Collaborate more effectively with assistants, stylists and subjects
• Tag, rate, compare and share images while
you shoot
• Share images on multiple devices
• Back up files to hard-drive while shooting
• Move images from laptop to desktop in an
instant
• Reduce the chance of image loss
Tethering is also an exceptional on-site teaching
tool for instructors and workshop attendees. Being able to view images on a large screen as they’re
captured facilitates discussion and helps students
master technical skills, refine techniques and develop their eye much more quickly.

NEW TO TETHERING?
Like any process, the more into it you get, the more
involved it can become, but setting up a basic tethered photography system is actually very quick &
simple. The easiest way is to try it out using equipment you may already have at home or in your studio. All you need is:
• A camera that supports instant image
transfer
• A compatible cable to connect your camera
to a computer
• Software to receive the images being sent

TO SET UP A SIMPLE SHOOT:
1.

Connect your camera, via the cable to your
computer

2. Start your software program
3. Set up a tethered capture session and select a folder to receive images

For a more secure and stable set up that can be
transported easily, you might consider something
like this:
• Camera of choice
• Tether Pro Cable that’s compatible with
your camera
• Laptop or tablet to receive images
• Cable retention device for your camera and
computer port
• Tether Table – to hold laptop for your
camera and computer ports
• Secure Strap – to keep laptop secure
• External Drive Compartment and back up
hard drive
• Tripod or C Stand – to hold laptop table
• Cross Bar & Ballhead - optional to also
hold camera

4. Begin shooting – and seeing your images
on your screen instantly
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TETHERING REQUIREMENTS

B

efore you can begin tethering, you need to
learn the specific requirements for both your
camera and computer.

CAMERA REQUIREMENTS FOR TETHERING
Most DSLR, mirrorless and medium format cameras are USB– or Firewire-compatible, meaning
they have a USB or Firewire port for copying images from a card to a computer. However this does
not necessarily mean that the camera has tethering capabilities. Tethering is the ability to transfer
images immediately during the capture process.
Growing demand for tethering has led manufacturers to introduce and improve tethering functionality in many newer cameras. Even so, you
should reference your camera manual to confirm
that it’s capable of tethering and if so, identify
which types of images it’s designed to transfer –
JPEG, RAW or both. Remember to look for the
phrases Direct Image Transfer and Instant Image
Transfer as well as any references to tethering.

Some camera models support Parallel File Writing, where images are written simultaneously to
both the memory card and the computer or tablet to which you are tethered. As of this writing,
Canon is the only manufacturer offering this solution. For those using Sony, Nikon and other manufacturers that do not offer parallel file writing in
camera, we offer some work-arounds later in this
guide. Some cameras require their manufacturers’
proprietary software in order to tether, while others can use many of the familiar tethering software solutions we discuss in Chapter 3.

COMPUTER REQUIREMENTS FOR TETHERING
For any working professional, time is money. To
avoid costly slowdowns and transfer issues when
shooting tethered, you need to match your computer’s RAM and processing speed to the size of
the files you’re transferring. As we cover the requirements for tethered photography from the
computer’s standpoint, you’ll want to check your
computer’s specifications to see exactly how your
machine has been configured.
Some important terms to know when reviewing
computer requirements:
• RAM: Random Access Memory
• RPM: Revolutions Per Minute
• SSD: Solid State Drive
• RAID: Redundant Array of Inexpensive/
Independent Disks
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The best place to start is with the computer’s
memory, or RAM - what many of us like to think
of as the “muscle” of the computer. When a photograph is being transferred through a wired or
wireless connection, the computer’s RAM has to
quickly process the image data so that the computer’s processor can display the image on screen.
Having enough RAM ensures that your computer
can:
• Connect effectively to your tethering
software of choice
• Perform at optimal transfer speeds so that
images appear quickly as they go from
camera to computer
• Support efficient post-processing of image
files
If your tethering computer doubles as your primary storage device, you will want to make sure
its hard drive has fast read and write times. Data
redundancy (having multiple copies of your data)
is key to keeping your data safe. The safest redundant scheme is the 3-2-1 system . At minimum,
we recommend that you maintain separate devices for your primary and archival storage. You
may also want the extra data security provided by
drive-spanning devices like a RAID .

For most tethering set ups, the following minimum configurations should be effective:

FOR LAPTOPS:
• Install at least 16GB of RAM
• Utilize external hard drives. They offer
larger storage capacities than internal
drives and are much more cost effective.
External drives also offer easy portability
for moving files to a desktop workstation
for post-production.
• Use hard drives with 7200 or faster RPM.
The higher the RPM the faster your computer can read and write large image files.

FOR DESKTOPS:
• Install at least 16GB of RAM
• Install large internal storage drives with
7200 RPM or faster to support file transfer
speed and capacity.
• Consider using a Solid State Drive (SSD) to
run software applications.

NOTE:
The drives you use for archive files do not have to
be as fast as those you use for capturing files while
shooting tethered.

• Be sure to check your camera’s manual to determine if it supports Instant Image Transfer. To access your
Canon camera’s manual online, select your camera’s model name, then scroll down to ‘direct image transfer’
to find out what type of image transfer options ( jpeg or raw or both) are available.
• To access your Nikon camera’s manual online, locate the ‘USB connector’ section of the manual to find out
which cable it requires to tether.
• To access your Sony Camera’s Manual Online, select ‘camera’, then click on your specific camera series and
model. Under marketing specs, scroll down to ‘interface’ which will show you the USB port that is required
for that camera. In the ‘user guide (printable pdf ), find the section called ‘remote camera control’ which will
show you how to setup your camera for tethering and provide information on downloading the software.
• Before purchasing a tethering cable, be sure to reference the Cable Compatibility Guide from Tether Tools.
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TETHERING SOFTWARE

T

his chapter addresses the software side of
tethered photography (the transfer, and in
some cases, transfer and copying, of image files
from your camera to your computer). There are
quite a few tethering software options out there.
We will cover the following:
• Adobe Photoshop Lightroom
• Capture One Pro
• Darkroom Core
• Smart Shooter
• Manufacturer Software
• 3rd party Software Options

Each section will highlight a software solution,
current supported cameras, and instructional setup guide as well as bonus information to improve
your tethering experience. (Please note the information covered in this chapter is based on the
software available at this time. Features change
frequently so check your software documentation
for the latest specifications.)

TETHERING SOFTWARE INTRODUCTION
Software developers continually upgrade features
and functions. To find a compatible software that
meets your needs, visit this Tethering Software
Finder at Tether Tools.com
There are many software options to choose from,
but some programs are more popular than others. Among the favorites of professional photogPhoto: Smart Shooter

raphers are Adobe Photoshop Lightroom, Capture
One Pro, Canon EOS Utility, and Nikon Camera
Control Pro.

ADOBE PHOTOSHOP LIGHTROOM
Adobe Photoshop Lightroom is a
comprehensive RAW processing and
photo management application that
includes tethering functionality for
select Canon, Nikon and Leica digital cameras. Lightroom offers only limited access
to camera settings directly from a computer but
fully supports instant viewing, zooming, rating
and tagging of shots. You can even set it up to import photos into a specific Lightroom catalog as
they are taken. Like all other tethering software,
Lightroom displays your high resolution files on
the tethered screen as you capture them, so you
can easily check focus, lighting and composition
in great detail. Lightroom is available for both
Windows and Mac.

LIGHTROOM SUPPORTED CAMERAS
The Adobe Camera RAW plug-in (ACR), which can
be accessed via Lightroom, supports hundreds of
cameras by various camera manufacturers. ACR
allows you to import photos, process those files
and convert them to other output formats. However, just because a camera is supported in ACR
does not mean it can be tethered using Lightroom.
Adobe camera RAW supported cameras
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LIGHTROOM INSTRUCTIONAL SET-UP GUIDE
Written by Terry White

This section will take you step-by-step through setting up your compatible camera to shoot via a tethering cable directly into Lightroom on your computer.
1. GETTING STARTED

The session name is the name that will be given
to the folder that your pictures will be placed in
as well as the name assigned to your pictures as
they come in. It’s best to keep this name short
and not use any special characters that could be
incompatible with your operating system. See dpBestflow’s section on file management for folder
and file naming best practices.
3. SEGMENT PHOTOS BY SHOTS (optional)

In most cases, it does not matter whether you
plug in or turn on your camera before or after
starting your tethering software. However, for
best practices, make sure your camera and tethering cable are not yet connected to your computer.
Launch Lightroom and Choose Tethered Capture
> Start Tethered Capture from the File Menu. You
will then see a dialog box where you can set all of
your options.
2. ENTER THE SESSION NAME

If you are capturing a number of different looks
or scenarios in a single session and wish to organize them into sub-folders within the primary
folder for the session, check the “Segment Photos
by Shots” box. If you leave the box unchecked, all
files captured in the session will go into a single
folder.

FOR MAC:

Shift

FOR PC:

Shift

T

Command

Ctrl

T

This will bring up a new window that lets you
name your next segment. Enter “Mike” for the
Segment name and Mike’s shots will now go into
this sub-folder.
Once you’ve created a new segment, you can still
return to any segments created earlier so if Ann
needs to go back on set, you can switch to her
sub-folder, and then go back to Mike’s.
4. NAMING
In the “Naming” section, you determine how you
want each shot to be named. Typically using the
“Session” or “Shot Name” and a 4-digit number (i.e. 0123) will work. You can either choose
a pre-defined naming template or create your
own custom settings. Refer to the dpBestflow File
Naming section for recommended best practices.

Let’s say you are doing a fashion shoot with three
models – Ann, Mike and Susan – and you want
to store the photos taken of each model in separate folders. You’ll start by giving a name for the
whole session – let’s say you give it the ‘Session
Name’ of “Fashion Shoot.” You will then check
the box for “Segment Photos by Shots” to create
folders for each of your models.

5. DESTINATION

Once you begin the session, another dialog box
will ask for the name of the first “Segment.” You
would then enter the first model’s name you will
be working with. Let’s say its “Ann.” When Ann’s
shoot is complete, all of the images will be in the
“Ann” sub-folder under “Fashion Shoot.” When
it’s time to photograph Mike, press:

6. INFORMATION

This determines where Lightroom saves the image data you’re transferring to this computer. You
should choose a location/drive that has plenty of
space for the number of images you anticipate
bringing in, especially if you’re shooting in RAW.
It can be an internal or external drive.

In the information section you can choose an existing metadata template or create one on the fly.
Lightroom will embed the information entered
here into the metadata of each image. At a minimum, we recommend embedding your copyright
info, name and studio website.

TIP:
You can save the metadata template and name it so
you can reuse the template instead of inputting new
information each time.

7. KEYWORDS
Inputting keywords is simple. Just make sure
you separate each keyword you add to your files
by commas. Once this is done, keywords can be
searched to help you find the images you want in
the future. Remember, keywords entered at this
stage of the process will be applied to all images
captured in this session. If you wish to apply more
specific keywords to individual images or groups
of images within the session, you will do that as
a separate step once those images are captured.
dpBestflow’s Keywording best practices can help
you develop an effective keyword strategy.
8. CONNECT YOUR CAMERA
When you click “OK,” Lightroom will bring up
the Tether Capture Window. Once that appears,
connect your camera using the compatible cable,
then turn your camera on. Shortly after you turn
on your connected camera, it will appear in the
Lightroom window. Now, you’re ready to shoot.

NOTE:
If you already have images on your camera’s memory
card, it may take longer than expected for your camera to appear as your computer will read it as a storage device and want to verify each and every image
on that card before showing the camera to Lightroom.
This means that it may look like your camera is not
connected for several seconds.
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Nikon & Leica Users
If you’re a Nikon or Leica shooter you can remove
the card(s) from your camera since shooting tethered with these cameras only sends the images to
your computer, NOT to your cards.

11. ENDING YOUR SHOOT
When you’re done with the shoot, click the “X”
in the upper right-hand corner of your Tethered
Capture Window to end your Tethered Capture
session.

Canon Users
If you’re a Canon shooter you can either remove
or erase the card so it doesn’t take as long for the
camera to show up on the tether bar in Lightroom.

DEVELOP SETTINGS TIP:
If you want images auto corrected as you capture into
Lightroom, use the Develop Settings in the tether window. Capture the first image and open it in the Develop
Module. Now, make any adjustments you want such as
White Balance, Crop, etc. When finished switch back to
the tether window and set the Develop Setting to “Same
as Previous.” All images moving forward will be adjusted using the same settings as the previous image.
10. HIDE THE TETHER CAPTURE WINDOW
Shooting tethered is fantastic but sometimes, the
tether window can get in the way of the images.
You can hide it by pressing the “F” key to enter
Full-Screen mode. Pressing the “F” key again will
take you out of Full-Screen mode whenever you
need to bring the Tether Capture window back
up. If you prefer to capture using Loupe view,
press the letter “E” on your keyboard. Once you
are in Loupe View, pressing “Command+T” or
CTRL+T” will hide or show the Tether Capture
window while you’re shooting.

FOR MAC:

Command

T

FOR PC:

Ctrl

T

• You can do this from within Lightroom’s
Web Module or use one of many third-party application plug-ins that will upload
images directly to a website.

LIGHTROOM QUICK KEYS
These quick keys offer time saving short cuts
when working in Adobe PhotoShop Lightroom.

TIP:
You can select which keyboard letter or number will
flag or color specific images depending on their rating. See tips on ratings here

9. CLICK OK AND LET’S CAPTURE
As you capture each image, it will be transferred
via USB to the folder on your hard drive that you
chose (and have displayed) in Lightroom.

port those into Photoshop for advanced
editing and photo retouching.

DEVELOP SETTINGS TIP:
Once the session is ended, Lightroom will stop importing any more images even if you continue to shoot with
the camera attached via cable. If you want Lightroom
to start importing images again after you’ve ended the
session, simply start a new session.
It is recommended to unplug your cable, coil and store
it properly at this point. If you wish to continue shooting untethered, and your camera’s LCD is disabled
during tethered shooting (common in some cameras),
removing the cable will return the LCD panel to normal
shooting functions. If you removed a card before your
tethered shoot, re-insert a card now to save images to
the card.

12. NEXT STEP FOR IMAGES
Once you finish your tethering session, the high
resolution image files are stored on your hard
drive just as though you had transferred them
from a memory card. You can now:
• Go through the gallery with your client/
model to select favorites by flagging or rating them.
• Choose the selected images that you have
flagged or rated within Lightroom and ex-

VIDEO: Mark Wallace shows a step-by-step set up for shooting tethered with Lightroom
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CAPTURE ONE PRO

CAPTURE ONE PRO SUPPORTED CAMERAS

Phase One’s Capture One Pro is a
professional RAW converter and
image editing software that also
includes extensive tethering features. It enables you to capture,
organize, edit, share and print images in a flexible
and efficient cabled tethering workflow. Phase
One also offers a tool/app that connects Capture
One Pro to an iPad, iPod Touch or iPhone so users
can present, rate, zoom and even trigger the camera wirelessly using compatible mobile devices.

Capture One Pro supports hundreds of cameras for
RAW file conversion but not all of these cameras
are supported for tethered image capture.

Take care to use good quality cables and observe
maximum recommended lengths.
3) Set the capture naming in the Next Capture
Naming tool

Written by David Grover

The Capture tool tab in Capture One Pro is the
gateway to tethered shooting with a compatible
camera via a USB cable.
This tool tab has a host of features to aid workflow.

START A TETHERED SESSION

- Use the Camera and Camera Settings tool to alter camera settings and fire the shutter
- Use Live View functionality for composition and
focus control

Check the Location of the Session, choose a Template* if you have one set-up, otherwise leave as
Blank. Leave everything else as default.

Capture One Pro has two options for file management. Images can either be stored in a Catalog
(Otherwise known as a Library) or a Session. The
Session based workflow makes the most sense for
tethered capture.

a) Decide on the Format by combining one or more
Tokens to build a naming convention. Tokens can
be chosen by clicking on the ‘…’ button.
b) Capture Counters can be reset in the tool sub
menu.

Once the session is created it will look like this in
the Mac OS Finder or Windows Explorer.

Capture Pilot is an additional tool and iOS application to connect Capture One Pro to an iPad, iPod
Touch or iPhone. The Capture Pilot app lets you
present, rate and capture image files remotely.
Capture Pilot also has a web function that lets
you view, rate and color tag captured images from
a web browser on a computer, Android device or
any other hardware with a simple web browser.

- Manage adjustments and naming during capture.

1) Start a new Session in Capture One by
browsing to File>New Session

Capture One supported cameras

CAPTURE ONE PRO 10
- STEP BY STEP TO TETHERED CAPTURE
Capture One has a long history as being the industry standard in fast and robust tethering. Compatible cameras from Canon, Nikon, Sony, Phase
One and Leaf can be connected for instantaneous
capture.

A Session simply creates a small group of nested
folders that contain everything from RAW captures, selected images, exported images and even
trashed images.

4) Adjust cameras settings and capture
The Camera tool will show us much information
as possible, depending on the camera attached.
Icons that are greyed out only show a particular
setting and cannot be altered.
*A Sesssion Template is a fast method of setting up
a typically used Session organisation to prevent repeated setup of the same parameters. Any Session
can be saved as a template by choosing File>Save as
Template

For example, if the camera has a mechanical Exposure Program dial, it is not possible to change it
in the Camera tool.

2) Connect a supported camera and verify the
connection in the Camera tool

Adjustments made on the camera itself are synchronised with Capture One.

Any setting that is highlighted, can be clicked on
and edited.
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6)Managing Files
Managing files is carried out in the Library tool
in the Library Tool Tab. The Capture, Selects,
Output and Trash folder can be viewed simply by
clicking on them.

By default, images are stored in the session Capture folder but it can be changed in the Next Capture Location tool.

7) Exporting Files

a. Select the image files for processing.
b. Go to the Output Tool Tab.
By default adjustments on the current image are
copied over to subsequent captures. However,
this can be influenced in the Next Capture Adjustments tool. There are options in here for changing the ICC profile, Orientation, Metadata and all
other adjustments from image to image.
A Style can also be applied on capture.

8) Additional Options

By default, captured images go to the session Capture Folder. Images can be moved to the session
Selects folder by drag and drop or selecting an image and using the shortcut Cmd(Mac)/Ctrl(Win)
– J. Images can be moved to the trash folder,
also by drag and drop or the shortcut Cmd(Mac)/
Ctrl(Win) – Backspace.
By default, exported images go to the session Output folder.

5) Applying Adjustments

Processing can be stopped at any time, then edited and re-started from the Batch Tool Tab.
a) Composition Mode. This mode allows the capture of images to assess exposure, composition
and focus, but without writing ALL images to
disk. Choose Camera>Composition Mode or press
the Composition mode icon*

For a more extensive list of camera settings, the
Camera Settings tool shows all possible editable
settings. This list will vary from camera to camera.

Press the Capture button in the Camera tool or
release the camera’s shutter to capture an image.

d. Press Process in the Process Summary tool or
use the shortcut Cmd(Mac)/Ctrl(Win) – D

c. In Process Recipes, check mark (or create a new
recipe) the required recipe(s) for the selected images.

i) Choose Camera>Auto Select New Capture.
ii) Select the update rate of new captures from the
following:
iii) Never - will show the chosen primary variant.
iv) Immediately - will show a new capture as
soon as possible (before all preview calculations
are done).
v) When Ready - will show new captures as soon
as all auto-adjustments are done.
vi) Auto Pause - will allow the viewing of a selected primary variant while the tethered session
continues.
c) Using an Overlay. An ‘Overlay’ can be any image file which is dsplayed on top of the capture.
This can be useful if you need to align tethered
captures to a particularly layout.

i) The Composition mode is activated as soon as
the X Icon is displayed in the Viewer.
ii) Remove the Composition mode to keep test
shot files.
Note: Each new capture taken in Composition mode
overwrites the previous one.
*The Composition mode icon can be added to the
toolbar. Go to View>Customise Toolbar
b) Adjust which images are shown during tethered photography. This option controls how new
captures are displayed in the viewer.

i) Go to the Capture tool tab.
ii) Drag and drop an overlay file into the specified
area.
iii) Adjust the overlay file if needed with the Opacity and positioning sliders
Note: The overlay file should be a PSD, RAW, TIFF,
JPEG or PDF. PC users can use a JPEG, TIFF, BMP,
PNG or a GIF.
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CAPTURE PILOT

c. Set a password if you wish

Capture Pilot lets you present, rate and capture
photos on an iPad, iPhone and iPod Touch directly from Capture One Pro software. The web function also provides additional means of viewing
and rating from a web browser on another computer, Android device or any other hardware with
a simple web browser.

d. Set Publish To to Mobile

Before you start: Download Capture Pilot from
the Apple App Store. Capture Pilot requires local
network Wi-Fi. Ensure your Capture One workstation and Capture Pilot device are on the same
network as each other.

a. Open Capture Pilot at the bottom of the Capture Tool Tab in Capture One Pro.

The Capture Pilot tool is located (by default) at
the bottom of the Capture Tool Tab.

c. Set a password if you wish

DARKROOM SOFTWARE
Darkroom Software is an end to
end photography business workflow solution. Darkroom Software
is ideal for on-site photography
events where time and efficiency

e. Press Start Image Server
f. Now open the Capture Pilot app on your iOS device and select your named Server from the Server List.
2) Connect to a web browser

b. Add a Server Name and choose a Folder of images from the drop down menu that you want to
appear in Capture Pilot
d. Set Publish To to Web
e. Select the Web tab, choose a theme from the
drop down menu

are key.
Whether you are taking and printing a few hundred pictures of children with Santa, or thousands
of pictures at a sporting or corporate event, Darkroom can manage your workflow from capture,
to graphics, layout, on-site printing, selling, and
cloud based e-commerce. Among other features,
Darkroom Software lets you:
• Catalog and browse images in event based
groupings

• Select from multiple preset packages with
multiple items for fast paced event printing
• Set up packages with pricing, invoice creation and reporting

f. Note the address given in Local IP and distribute to anyone who wishes to connect. Enter this
address into any web browser to connect to Capture Pilot.
Note – To connect to both Mobile and Web, choose
Mobile and Web in the Publish To menu.
1) Connect your iPad, iPhone or iPod Touch to
Capture One
a. Open Capture Pilot at the bottom of the Capture Tool Tab in Capture One Pro.
b. Add a Server Name and choose a Folder of images from the drop down menu that you want to
appear in Capture Pilot

Other Resources
https:// blog.phaseone.com
https://www.youtube.com/user/PhaseOneDK
www.captureone.com

• Drag and drop images into pre-setup templates for fast chroma-key or regular prints

• Design with templates can be categorized
and selected quickly

• Shoot tethered directly into pre-setup templates

• Adjust templates for text input and data
import to quickly customize output

• Connect directly by USB to most Canon
and Nikon cameras as well as hot folder
monitoring for wireless image import

• Support multiple printers with load balancing to speed output
• Work with various industry leading printers, with built-in drivers for simpler setup
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SMART SHOOTER
Smart Shooter is a digital photography work flow application for tethered shooting, remote capture and
advanced camera control.

Smart Shooter works with all recent Canon EOS
DSLR and Nikon DSLR cameras, with both Windows and Mac OS X computers.

MANUFACTURER SOFTWARE
Many of the camera manufacturers have their own
tethering software. The list of software includes:

CANON EOS UTILITY

Smart Shooter is aimed at both the professional
and amateur photographer, providing them with
the following features:
• Remote camera control via USB cable

Canon EOS Utility software
is available free with Canon
cameras and includes many
of the features found in purchased software packages such
as transferring and viewing RAW images or JPEG
previews, rating and tagging images, remotely controlling the camera, displaying live view (if camera
supports it) and other tethering functions. Available for both Windows and Mac, the initial EOS
Utility installation requires the original software
disk that came with the camera. Once installed,
updates can be downloaded directly from Canon.

• Full control of camera settings
Smart Shooter allows you to fully control your
camera from your computer, giving you freedom
to explore and experiment to help take the perfect
picture. Automatic download and display means
you can fully evaluate your photos in seconds, and
real time live view output will help you focus and
compose the scene. Scripting language lets you
control your camera, allowing you to take multiple photos with varying settings just by clicking a
single button.

• Automatic photo download and display on
you computer
• Real time zooming/panning photo display
• Live View display including overlay mode
• Bulb shooting with timed exposure
• JPEG and RAW file formats
• Connect and control multiple cameras
• Automatic control via scripting
• Barcode scanning/filenaming directly from
photos

NIKON CAMERA CONTROL PRO
Nikon Camera Control does not
come with Nikon cameras, but is
sold separately and is a full-feature tethering software package
that allows full control of all compatible cameras’ settings. Available for Windows
or Mac, Nikon Camera Control Pro software re-

motely controls most functions of Nikon digital
SLRs from a computer that is connected via USB
cable or wireless transmitter. Advanced functions including camera controls, live view function, and presets are also supported through the
Picture Control System. It also offers the optional workflow of using Nikon’s exclusive processing and editing applications, Capture NX and
View NX.

HASSELBLAD PHOCUS
Phocus is a free software package
designed for processing Hasselblad
RAW files and for tethering Hasselblad cameras via cable. Available for Mac and Windows, Phocus
software offers common tethering features and
remote functions, such as remote focusing, live
view, exposure controls, and advanced processing
features such as moiré removal, batch processing
and camera calibration to name a few. Hasselblad
also offers Phocus Mobile, which wirelessly integrates an iPad or iPhone into the workflow enabling users to remotely browse and rate images in a session when the camera is connected to
the app either tethered to a computer or via wifi
for enabled cameras. Phocus Mobile can be used
for remote operation and triggering of a tethered
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camera, control of exposure mode, f-stop, shutter speed, ISO, metering mode and other important capture parameters, all presented in a virtual
camera display.

• Backyard eos

SONY REMOTE CAMERA CONTROL

• Darktable

Sony Camera Remote Control
is a free software package for
Alpha Series DSLR’s that runs
on Mac or Windows platforms. The program is available on the bundled software disc included with
the camera purchase. Although limited in features, the software does provide access via USB
cable to control some camera settings like shutter
release and white balance control. Once the software is installed and up and running, there is a
handy little work-around to tether a Sony Alpha
into Lightroom or Capture One in order to access
some more robust features.
Select sony cameras are also supported by capture
one pro to offer more robust tethered capture features, digital asset management, extensive adjustment tools and a more flexible workflow for sony
shooters. supported sony cameras can be found
here.

3RD PARTY SOFTWARE OPTIONS
The software covered so far represents the most
popular options but not all cameras are supported by them. Plus, some other applications offer
additional features such as multiple camera control, advance time lapse, hdr features and more,
which you may find valuable. Tether tools keeps
an up-to-date resource list of currently available
tethering software that includes a brief description of each product. The following applications,
in particular, may be worth exploring:

• Backyard nikonbreeze systems
• Camerarc
• Controlmynikon
• Digicamcontrol
• Dna software
• Entangle
• Fuji hyper-utility software
• Fuji-flim tethered capture plug-in for lightroom
• Kuuvik capture
• Olympus capture
• Pk_tether
• Promote systems usb tether for lumix
• Sofortbild
• Tetherpro
View your options here.

TIP:
Even when shooting cabled into a computer software
program, you can still wirelessly mirror the images
from your computer to a tablet or smartphone for additional viewing preferences. Applications such as Air
Display and Capture Pilot exist to help achieve your
desired configuration.

FILE MANAGMENT RESOURCES

O

ne of the most important things you can do
for your workflow is to create an organized
file management system. This process of naming,
storing and handling image files, coupled with
smart metadata and quality archival software, can
be the key to your success.
ASMP has compiled the industry’s best resource
for workflow file management on the dpbestflow
website. Developed with funds awarded by the
united states library of congress through its national digital information infrastructure and preservation program (ndiipp), the project was created to develop a public resource with guidelines for
all creative professionals on best workflow practices in digital file management and archiving.
Tethered photography enhances the efficiency of
your workflow – especially when paired with an
effective file management system. We recommend
reading the articles at each of the following links to
ensure your personal file management system will
withstand the test of time and a growing library
of files:

BOOKS
Digital
Photography
Best
Practices
and
Workflow
Handbook
(Focal Press, 2009) by
Richard Anderson and
Patti Russotti. Richard
Anderson was a key parPhoto: Moshe Zusman

ticipant in the initial creation of the dpbestflow
project. The book presents workflow practices
for planning, capturing and archiving digital photography.
The DAM Book, 2nd Edition (O’reilly Media, 2009)
Author Peter Krogh was
another key member of the
original dpbestflow team.
His book on digital asset
management is an essential guide for photographers
moving from film to digital and shows how all the
components of a digital photo library fit together
into a comprehensive system.

GUIDES
The DAM Book Guide to
Organizing Your Photos
with Lightroom 5 (Dam Useful Publishing, 2014) by Peter
Krogh. In this multi-media
ebook featuring 10 chapters
and 7 hours of video, peter
krogh uses his own extensive image library to explain a simple theory of organization based on a
three-step approach that will help you sort your
image library, streamline your workflow and get
your images out into the real world quickly and
easily.
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The DAM Book Guide to
Multi-Catalog Workflow
with Lightroom 5 (Dam
Useful Publishing, 2014) by
Peter Krogh. Building on
the principles first laid out
in the dam book, this 113
page multimedia guide establishes the principles of
solid multi-catalog workflow, defines the terminology necessary to understand the process and shows you the workflows in
action. Packed with more than 3 and a half hours
of videos and clear step-by-step lists, it will help
intermediate and advanced lightroom users create
clarity in their workflows.

ARTICLES:
• File Management Overview,
written by Richard Anderson &
Peter Krogh
• Directory Structure,
written by Richard Anderson &
Peter Krogh
• File Naming,
written by Richard Anderson

Photo: Joe McNally

TETHERING WITH CABLES

T

raditional tethering is the process of connecting a cable from camera to computer
and transferring images immediately while shooting. Depending on the equipment you’re using,
your shooting style and your needs, you may prefer wired or wireless tethering. This chapter will
focus on wired tethering, (where a cable physically connects your camera to your computer or
device) and the specific process of choosing the
right cable and set up for your tethered photo
shoot. Chapter 6 will address wireless options.

IMPORTANT CONSIDERATIONS
Critical factors for selecting the right cable for the
job include protocol, compatibility between the
camera and computer or tablet, reliability, speed,
length and security. Photography requires a tremendous amount of data to be transmitted and speed
is critical, therefore tethering cables should be
designed to the highest specifications.
Any interference with the transfer of your images
between your camera and storage device can cause
corruption or data loss so look for cables that are
fully shielded to protect against external interference, noise and transmission errors. Be sure your
tethering cable has heavy cable insulation and interior braiding as well as strong port casings and
connectors to minimize issues.

the life of a cable. To ensure cables perform at optimal quality, protect them from being stepped on
or tripped over. Don’t place stands on top of them
and avoid rolling carts over cables. Connectors
are one of the most fragile parts of your cables so
avoid jerking them while tethered or when disconnecting the cable from your camera or device.
Later in this chapter, we’ll outline how to properly secure cables and protect ports.

TIP:
Want your cables to last longer? Here’s a link to 5 Tips
on how to properly care for your tethering cables.

BASIC CABLE CARE

SELECTING THE RIGHT CABLE FOR YOUR
CAMERA

Properly coiling cables and using cable cases for
storage and transport will dramatically extend

Most cameras include an HDMI port and a FireWire and/or USB port. Today, USB is the most
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For best results, use USB cables and extenders that
are the same protocol as your camera. If your camera is USB 2.0 hi-speed, use USB 2.0 hi-speed cables
and extenders all the way through, even if your
computer uses USB 3.0. The computer will recognize the USB 2.0 protocol and convert the signal
properly at the end. Mixing USB 2.0 and USB 3.0
cables can cause an increased drop rate resulting
in data loss.

Wire port, and to identify the pin count and configuration of your port, for example 5-pin, 8-pin,
mini, micro, etc. Tether Tools keeps a comprehensive cable type and compatibility resource on its
website for reference.

VIDEO: How to set up a tethered connection from your camera to your computer

Find the right cable for your camera with Tether
Tools’ Cable Finder.

If the camera is USB 2.0, that will be the maximum speed transfer rate, even if you use faster
cables as speed is dictated by the slowest device
in the chain. If you experience signal loss issues
at any USB speed, adding an externally powered
USB booster like the TetherBoost Pro USB 3.0
Core Controller can help alleviate challenges with
mixed USB protocols.

CABLE LENGTH
commonly used transfer protocol for tethering because of its quick and reliable data transfer properties. FireWire is traditionally used with Digital
Backs and some older DSLRs.
HDMI is popular for mirroring the camera’s rear
display to a larger monitor or when working with
video files, but it does not offer the image portability needed to transfer data into a tethering
software program.
It is important to determine if the camera has USB
2.0 Hi-Speed, USB 3.0 SuperSpeed and/or a Fire-

The optimal base cable length for most tethered
shoots is 15ft. (4.6m), an industry standard. This
length allows for a reasonable amount of movement without feeling too constrained. If a greater
distance between camera and computer is desired,
Active Extension USB cables or FireWire boosters
can be used to extend the length. It is not recommended to use a single cable that’s longer than 15
ft (4.6m). Moving your data from one end of a longer cable to the other without an Active Extension booster increases the chance of signal noise
and transmission errors. By using a 15 ft (4.6m)
base cable with the proper extensions and boosters you can achieve longer distances without sacrificing speed or signal strength.

NOTE:
Adding distance with USB cables can vary depending
on the USB Protocol your camera uses. Read below
for specific tips on achieving a consistent signal at
longer cable distances.

USB 2.0 HI-SPEED CABLES
For USB 2.0 Hi-Speed protocol you have the option of “daisy-chaining” Active Extension cables
out to a maximum of 80 ft. (24.4 m). To achieve
that length, you’ll have to use one base cable and
then add on multiple Active Extension cables,
which can each be up to 16’ long.
Rather than connecting the USB Male A plug coming out of your camera directly into the computer,
you would plug into a signal booster attached to
another 16 ft. of cable. The extension cable is then
plugged into your computer. If you use high quality shielded Active Extension cables such as the
TetherPro 16-ft Active Extension cables, you can
add up to 4 cables, for a total of 80 ft. without
experiencing any signal loss or interference.
Active Extension Cables are required every 15 ft
(4.6m) in a tethered session. Protect the connection with a case such as the JerkStopper Extension Lock.

USB 3.0 SUPER SPEED CABLES
The USB 3.0 Super Speed protocol can transfer
large files faster than USB 2.0 but requires more
power and cannot achieve as long a distance.
Extending USB 3.0 cables beyond 15-30 ft (or the
equivalent of one 15-ft base USB 3.0 cable plus one
16-ft Active Extension cable) can cause the computer to drop the camera connection.
Because of the additional power requirements, and
inconsistencies within the newer USB 3.0 firmware deployed by camera and computer manufacturers, optimal transmission speeds and consis-
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VIDEO: Determine if your tethered connection requires a TetherBoost Pro USB 3.0 Core Controller

SECURING YOUR CABLES & CAMERA
One of the most common challenges of tethered
shooting is ensuring that movement on the set
does not interfere with cable connectivity. Most
camera cable ports are fairly shallow and do not
lock the cables into place. As a result, cables can
lose connection and even fall out quite easily. Add
in the photographer’s need to move quickly and
the very real possibility of people accidentally
tripping over or stepping on cables and you can
wind up with frequent disruptions and lost data.
There are three major connections that can be affected – the camera port, the computer port and

tent signal/data transfer are only achieved when
using a powered booster such as the TetherBoost
Pro USB 3.0 Core Controller. This is recommended whether you’re using just a base 15-ft cable or
a base 15-ft cable plus multiple 16-ft active extension cable configurations. For more on this topic,
read this helpful article: Why Does My USB 3.0
Connection Fail?

TetherBoost Pro USB 3.0 Core Controller

tects you from costly disruptions and data loss,
not to mention hundreds if not thousands of dollars in preventable cable and camera port damage.

SETTING UP A CABLED TETHERED WORKSTATION
It’s easy to create a streamlined tethered setup that
meets your needs for every imaginable situation:
• Transferring images to a desktop, laptop
or tablet
• Shooting handheld or on a tripod
• Working in studio or on location
• Working solo or sharing images with
assistants, subjects and clients
Here are a few common set ups that work well
for the majority of photo shoot scenarios but
don’t let these limit your imagination. Whatever
your shooting situation, you can find mounting
solutions that will help you tether easily and efficiently.

FIREWIRE CABLES
FireWire cables are also a standard protocol cable
option compatible with select cameras. Chapter 7
features a special section on shooting with digital
backs and medium format cameras, where FireWire ports are most commonly found.

USB-C CABLES
Apple’s latest announcement that their MacBook
Pro line will have only USB-C port connections is
a very exciting development as USB-C will bring
faster speed and more robust power solutions to the
marketplace. At the time of this writing, the majority of camera manufacturers have USB 2.0 and USB
3.0 ports in their cameras and as such, there is no
real advantage to using a USB-C cable. While there
are many benefits to the USB-C protocol, owners
of existing USB2 and USB3 cameras will not see
an increase in speed or performance. It is our recommendation that if you have, or are considering
purchasing, a computer equipped with only USB-C
ports that you use the USB-C to USB-A adapter.

JerkStopper Camera Support

if using an active extension cable or booster, the
mid-point connections. Each of these connections
can be secured with a simple tool.
Cable retention devices, such as the Tether Tools
JerkStopper Camera Support, Computer Support
and Extension Lock, protect each port by anchoring the cable so that any pressure from jerks or
pulls is shifted away from the cable port itself.
Cable retention devices also ensure the plug stays
connected at all times. Taking this precaution pro-

Photo: Douglas Sonders
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check your images during the shoot. This is key to
achieving an efficient tethered work station that
fosters communication with those on set.
A portable laptop table that can be mounted securely on a tripod or stand, such as the Tether Table Aero System, will allow you to create a lightweight workstation that can easily be adjusted to
a convenient height for comfortable use on location or in studio.
Rolling wheels can offer added mobility. Be sure
to select a table that’s large enough for your needs.
You may also wish to consider a cooling pad for
your table – in addition to preventing overheating,
the non-slip surface helps keep your laptop secure
and protects the table from dings and scratches.
It’s smart to invest in security straps that will
keep your laptop in place if bumped or tipped.
If you are backing up images to a hard drive during
your shoot (as recommended in Chapter 8, you’ll
want a system that supports your back up drive
securely, keeps loose cables under control and
keeps it out of your way. A compartment that
attaches underneath the laptop table, like the
Tether Tools XDC External Drive Compartment,
provides an ideal solution.

The most common tethered workflow involves
shooting directly into a laptop computer. The first
thing you’ll want to determine for your workstation is where you’ll place your computer and camera on your shoot. You’ll need to consider where
your subject will be, how much you’ll need to
move around and how long of a cable you’ll need
for each particular shoot. It is also very important to consider how you will keep your gear safe
and secure. Plan to keep the camera close enough
to your subject and your computer mounted close
enough to your shooting area that you can quickly

place your gear at a shoot, such as product photography or step and repeat event photography.
Having the ballhead on top of the crossbar also offers a convenient place to put your camera during
breaks from handheld shooting.
If you prefer to mount your laptop to a C-stand,
you may want to consider a side arm so you can
mount your table to the center column and still
be able to mount camera, lights, monitors or other peripherals on top of your stand.
When shooting tethered in bright conditions it
is often hard to see the screen clearly. Adding a

sunscreen for your laptop such as the Think Tank
Pixel Sunscreen can help with glare issues. The
Pixel Sunscreen design is ideal because the overthe-head shade blocks out most all light, allowing
you to see the screen clearly. The openings on the
side allow the tether cable and hard drive connector cable to exit the sunscreen on each side of
the laptop. The side openings also allow a Secure
Strap to attach to the table, holding down both
the laptop and Sunscreen. Should a gust of wind
catch the sunscreen, the laptop will still be securely attached to the Tether Table.

FEATURED PRODUCTS:

 Case Air Wireless Tethering System
 RapidMount Accessory Extension Bar

The Ultimate Workstation










 Aero ProPad - Traveler
 Tether Table Aero - Traveler
 Aero Cup Holder

 



 Aero XDC

 Secure Strap
 Aero Marketing Brochure Holder







 Aero Clip-on Hook
 TetherBoost Pro USB 3.0 Core Controller
 TetherPro USB 3.0 Cable Micro-B 5-Pin
 JerkStopper ProTab Cable Ties - Small







 Rock Solid External Battery Pack (10,000 mAh)
 StrapMoore
 Rock Solid Tripod Roller
 Rock Solid Master Clamp
 Rock Solid Master Articulating Arm
 AeroTab Universal Tablet System
 Rock Solid Tripod Cross Bar
RECOMMENDED ACCESSORIES:

Adding a crossbar, such as the Rock Solid Tripod
Cross Bar, allows you to use the same tripod to
support both your laptop and your camera. This
is beneficial when you have a small footprint to



JerkStopper
Camera Support*

JerkStopper
Clip-on Support*

JerkStopper
Extension Lock

$ 16.95 (SKU: JS020)

$ 9.95 (SKU: JS022)

$ 8.99 (SKU: JS026)
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WIRELESS TETHERING

I

n today’s digital environment, there are more
and more options to integrate wireless technology into our daily lives and work. That also
holds true when discussing tethered photography options. The definition of tethering as we’ve
outlined so far in this guide has related to using
cables and software to capture RAW or JPEG image files directly to your computer’s hard drive.
Advancements in wireless image transmission
have broadened the definition of tethering. While
many of the same benefits of cabled tethering can
be achieved with wireless transmitters, there are
still significant differences in the image file transfer aspects of “wireless tethering”.
In this chapter, we’ll outline the benefits and limitations of wireless tethering and how they compare to tethering with cables so you can decide
which approach will work best for your business
and your clients. Depending on the range of work
you do, it may make the most sense to use cables
for some shoots or clients, and tether wirelessly
for others.

Photo: Tether Tools

Case Air Wireless Tethering System

WIRELESS TRANSMISSION
Wireless transmitters vary much more widely in
their functionality than cables. This is specifically
because each transmitter has its own proprietary
receiving application and/or file structure depending on each brand’s transmitter. These differences, charted on page 40, introduce key points
to consider when deciding if wireless tethering is
the right option for you.
First, not all wireless devices are able to transfer
RAW files. For those that do transfer RAW, as of
this writing, the standard Wi-Fi protocol (Wireless N) is just too slow to transfer the larger RAW
files without unacceptable delays.
Secondly, you’ll want to think about the impact
of wireless tethering on camera batteries. Unlike tethering with a cable where battery impact
is negligible some wireless transmitters can be a
substantial drain on the camera’s batteries.
As outlined in the next section, there are several
different types of wireless transmitters used for
tethering. Built-in wireless and many manufacturer-specific transmitters use the camera’s internal batteries so if frequent battery changes are
too disruptive for your working style, they may
not be a good solution for you. Other transmitters
have their own built-in battery but those add bulk
and weight as well as another battery/charger to
manage. These trade-offs are all worth serious
consideration.
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WIRELESS TRANSMITTER OPTIONS

WIRELESSLY TETHERING AT A CORPORATE EVENT
WITH THE CASE AIR
Photos and Written by Nicole Chan

I have a photographic style that is a mix of documentary and beautiful, casually posed portraits. I
was recently hired by a corporate client, Pepsi, to
capture New England Patriots quarterback Tom
Brady with 250 guests.

Here’s my full setup:
• Canon 5D Mark III
• 24-105 f/4
• Einstein light with umbrella
• Pocket Wizards
• Tether Tools Case Air Wireless Tethering
System
• DNP printer
• Asus laptop

This is a large event for PepsiCo’s top level management as well as the one corporate event that
Tom Brady attends and speaks at. The event organizers wanted approximately 250 people to be
able to have a photo taken with Tom Brady and
then have their photos instantly printed, inserted
into a branded photo sleeve, and then distribute
to the attendees within minutes. The printing and
sleeve station must be on the 2nd floor, about 200
feet away from where the photos were taken. The
time we had with Tom Brady was short, as well.
The location and time constraints added pressure.
Instead of running a 200 foot USB connection, or
using assistants with SD cards, I opted instead to
use the new Case Wireless Tethering System from
Tether Tools to wirelessly connect my camera to
an Asus laptop and DNP printer.

Since the event coordinators wanted the photos
printed and delivered immediately, tethered was
the only way to go. I have an extremely long USB
cable that could have made it from the area I was
shooting to the printer, but securing it down with
gaffers and running it up to the 2nd floor wasn’t
something I wanted to mess around with.
I had heard unhappy stories of previous photographers working this event. They shot 10 to 15
groups and then had an assistant run the SD card
up the stairs to where the printers were. It seemed
disorganized and left many opportunities for error. While I have no doubt that my assistants Jarrett and Jason are excellent sprinters, I wanted to
keep this running-cards-up-and-down strategy as
a backup option.
The Case Air performed smoothly and excellently,
I wish I had discovered it earlier for any commercial, portrait, and advertising work where I am
working with a team. I think real-time feedback
is excellent so that I can communicate with my
team on likes, dislikes, and modifications.

The Case Air Wireless Tethering System connects
to the camera through the USB port. It creates its
own wireless connection between the camera and
a phone, tablet, or computer application that is
receiving the images.

HOW WIRELESS TETHERING DEVICES
WORK
Wireless transmitters are designed to send data
from one device to another without cables in between. Some wireless tethering devices require
you to be hooked up to an existing wireless network to transfer data. Existing wireless networks
are often more robust as they are designed for
many devices using the same network.
Other wireless transmitters actually work as adhoc networks, creating the connectivity directly
between camera and device without needing an
existing network. Ad-hoc networks allow use of
your wireless device in remote locations where no
existing wireless network can be found.
Wireless tethering transmitters can typically
send images to any computer/laptop, iPad, tablet
or phone. The most common are devices running
iOS, Android, Mac and Windows operating systems.

It is important to note that while there are differences in cable quality, speed, build and signal reliability which can affect a tethered shoot, all cables
are technically designed to work the same way, given the same camera and computer/software set ups.
Wireless transmitter manufacturers, however, use
a variety of different technologies and each has its
own proprietary software or application that receives the information being transferred. These
differences in transmitter type and applications
create large variances in what wireless transmitter systems can do for you. Here are the most
common types for DSLR, mirrorless and Medium
Format cameras.
1.

DSLR Built-In, Plug-In and Wireless Cards

2. Camera Manufacturer Solutions
3. Non-Proprietary 3rd Party Wireless Solutions
4. Medium Format Digital Back Wireless
Built-In Transmitters.
Each of these transmitters typically sends images
to an application or folder on either an iOS, Android, Mac or PC device (not all operating systems
are supported by all devices). Beyond that their
set up and available functions vary depending on
the type and brand you choose.
The following pages provide more detail for each
of these options. As you read further, keep in mind
that your preferred workflow and the needs of
your clients should be your most important selection criteria.

DSLR BUILT-IN, PLUG-IN AND WIRELESS
CARDS
At the time of writing, DSLR Built-in, Plug-in and
Wireless SD Cards make it possible to send im-
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age data wirelessly to a smartphone or tablet. All
of these tools support image transfer to a simple
photo app such as your camera roll that will allow
for minor edits, social sharing or emailing the image.
Built-in and Plug-in devices usually do not transfer
raw images, nor do they connect to software with
processing, rating or zooming functions. These
tools are designed primarily for sharing purposes
to a phone or tablet photo album or camera roll.
In this way, these tools are similar to Wireless
SD Cards, which have a small internal transmitter that let you send images wirelessly for social
sharing purposes or post-shoot uploading without removing the card from the camera. The JPEG
images are actually transferred and are saved in
the device’s camera roll until they are uploaded
elsewhere or deleted.
Some Wireless SD Cards can transfer RAW images
to personal device camera rolls or to a designated
folder on a computer. The device to which the image is being transferred will determine whether it
is feasible and desirable to move large image files
wirelessly. “Camera Rolls” on phones and tablets
have lower storage limits so sending smaller image
files such as a JPEG instead of RAW is preferable.
Wireless SD Cards have relatively small wireless
transmitters and it may take a long time for each
image to transfer to the device of choice.
Check your camera manual to determine your builtin wireless support. To achieve higher-level functions like zoom, rate, tag and two-way camera
control functions, live-view, HDR, etc., you’ll
want to look at the Camera Manufacturer Solutions, Non-Proprietary 3rd Party Wireless Solutions and Medium Format Digital Back Wireless
Built-In Transmitters outlined below, all of which
offer more robust features.

CAMERA MANUFACTURER SOLUTIONS

To achieve the more robust features found in
wired tethering workflows, DSLR shooters need
to attach external transmitters to your camera.
These may be made by your camera manufacturer
or a third party.
This section focuses on attachable transmitters
made by camera manufacturers. We cover third
party transmitters in the next section.
Typically, camera-manufacturer attachable transmitters are designed to send images to an FTP
server or computer. Once an FTP connection is
completely set up, the connection sends RAW or
JPEG files directly into the chosen server. (Note:
RAW file transfer is going to be a slower process
than JPEG, especially if sending to an FTP server
rather than directly to the computer.) The set-up
for these solutions tends to be a little more technical and requires some knowledge of working
with an IP address and FTP configuration. Refer
to the device’s manual for set up options and instructions as each one varies.
Once set-up, manufacturers’ attachable wireless
transmitters offer Live View and Camera Control
through a computer or portable device such as a
tablet or phone.
Most of these devices are camera-model specific
so if you have multiple camera bodies, multiple
transmitters may be needed. Keep in mind, too,
that most of them run off of the camera’s battery,

so you will want to have plenty of back up batteries as you may need to change batteries more
often during shoots.

about the two most popular medium format builtin wireless options: CapturePilot (PhaseOne) and
Phocus Mobile (Hasselblad).

NON-PROPRIETARY 3RD PARTY WIRELESS
SOLUTIONS

CONNECTING TO MULTIPLE DEVICES

Third party wireless tethering systems like the
Case Air Wireless Tethering System are designed
to be compatible with multiple camera manufacturers and various models. These systems typically focus on Nikon and Canon DSLR camera models.
Third party systems send images directly to an
application on your phone, tablet, or computer.
Most offer plug and play solutions that are easier to set up than an FTP connection and support
many pro level features including camera setting
controls, liveview, timelapse, HDR, shutter control, and more.
These solutions, like the Case Air, create an adhoc network connection between your device of
choice and camera and are compatible with mobile (iOS and Android) and laptop and desktop
computers (Mac and Windows). These transmitters allow JPEG files to be sent directly to the devices of choice while retaining the original JPEG
or RAW file on the camera card.

MEDIUM FORMAT DIGITAL BACK WIRELESS
BUILT-IN TRANSMITTERS
Many Medium Format Cameras/Digital Backs offer built-in wireless transmitters with more robust functions than typical DSLR built-in wireless transmitters. They come with their own
feature-rich applications which include rating,
tagging, editing and sharing options. They are
also capable of two-way wireless communication
which allows for adjusting camera controls and
triggering from the connected device. Learn more

Some wireless transmitters allow you to connect your
camera to multiple devices for image transfer.
Check the device’s features and manual to set this
up properly for your device. More commonly, certain DSLR and Medium Format cameras offer the
ability to connect a portable device such as tablet
or phone into a cabled tether session running on a
host capture laptop or computer.
This approach allows a client or assistant to re-

view and rate images on the mobile device while
the files are transferring via cable to a computer. The mobile device can also be used to control
camera settings and trigger the shutter remotely.
Hasselblad´s mobile application for this process is
called Phocus Mobile. Phase One/Mamiya Leaf uses
Capture Pilot. Capture Pilot can also be used in this
way with any Camera supported in Capture One.
This is a very convenient and a powerful tool as you
can technically be shooting in a location that does
not have any access to WiFi networks, and still be
using a tablet or phone for capture and review.
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SHOOTING WIRELESS INTO YOUR CATALOG
WITH WATCH FOLDERS

SETTING UP A WIRELESSLY TETHERED
WORKSTATION

When shooting wirelessly to a computer or laptop,
your images will be transferred to the proprietary
application associated with your wireless device.
However, if you would like to shoot wirelessly
and import your images directly into your favorite
catalog software program, you can set up a simple
workaround.

To ensure your wireless tethered shoot runs
smoothly, be sure to follow these important steps.

Most catalog applications, including Lightroom
and Capture One, come with a functionality called
“Watch Folder” or “Hot Folder.” This functionality has the effect of telling your catalog software
to watch a certain folder on your computer and
to automatically “pull” any images received in the
Watched Folder into a specified folder in your
catalog.
By setting your capture folder up as a Watch
Folder (or Hot Folder) in your catalog application,
your wireless captures will be imported into your
catalog automatically.

Make sure your wireless transmitter batteries,
camera batteries, tablet and/or mobile phone are
fully charged before your shoot.
Plan to have back up power source like a Rock
Solid External Power Bank or back up batteries
on hand in case your batteries run down.
Have a backup tethering cable available in case
the wireless device does not function as needed or
the Wi-Fi signals are jammed or unavailable.
Create a set-up that keeps your viewing device
conveniently accessible and secure. The optimal
set-up will depend on whether you plan to use a
computer, tablet or phone and the make or model
of the device. You may want to consider investing
in a specialized mounting system for your laptop,
tablet or phone that can securely attach to your
tripod or stands and that will keep your devices
safe and within easy reach.

WORKING WITH MEDIUM FORMAT

M

edium format digital backs and cameras have somewhat different requirements than DSLRs.
We’ve invited Danish photographer, Anders Espersen to share his insights on what you need to
know when shooting tethered using medium format systems.

MEDIUM FORMAT DIGITAL BACK TETHERING
Written by Anders Espersen

Medium format digital cameras have used tethering since the first commercial digital back from
Leaf was introduced in 1991. In fact, for many
years, until digital backs and cameras started using memory cards, tethering to a computer was
the only way to view and save digitally captured
images. Even today, with the added versatility, speed and ISO range of medium format digital cameras (such as Hasselblad, Phase One and
MamiyaLeaf ), tethering is still the preferred way
to shoot for many photographers who use these
camera systems both in studio and on location.

ADVANTAGES OF MEDIUM FORMAT CAMERAS
A medium format digital camera is slower and
heavier to work with than most DSLR systems
but in return offers much greater image quality,
resolution, control and creative performance ability.
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The fact that the medium format full-size CCD
and CMOS sensors are more than twice as large as

a full frame 35mm CMOS sensor makes for higher resolution, higher dynamic range and more
clarity in the final files. This, along with equally
larger and predominantly high-performance lenses, helps ensure generally superior image quality across the different brands of medium format
cameras.
For me, shooting with a medium format camera
encourages me to stop and think before I shoot.
The system simply requires you to work in a more
controlled way and the final result shows that extra care. If you haven’t picked up a medium format digital camera and looked through the viewfinder, you should! Comparing the viewfinder of,
say, a Hasselblad H5D with a DSLR, is like going
to an IMAX theater and then watching a movie
on your iPad. Viewing the scene through a Medium Format camera lets you see everything much
more clearly, compose your shot more accurately and
work with a level of refinement that cannot be easily
achieved using the smaller viewing field of a DSLR.
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Besides that, there is the “he or she’s a pro” factor
with your clients. You stand out from the crowd
– you differentiate yourself and make your clients feel they get more value for their money,
which of course they do!

MODES OF CONNECTIVITY AND SOFTWARE
SOLUTIONS
Connecting a digital back or medium format digital camera to the computer has, for many years,
been restricted to using the Firewire standard,
simply because this has offered the highest and
most stable data throughput. USB 2.0 has never
really been considered an option due to its significantly slower transfer speed. With the introduction of USB 3.0 and the gradual discontinuation
of FireWire, we have seen USB 3.0 connections
appear in, for example, Phase One IQ and Leaf
Credo digital backs. With RAW file sizes of up to
80mb, a fast and reliable connection is naturally
required.
Unlike the DSLR market, where there are a number of both proprietary and third-party software
solutions for processing and capturing images,
digital medium digital format cameras for the
most part rely strictly on proprietary software
solutions. This is because the camera manufacturers want to secure the best possible image quality for their platform and not rely on third-party
software that might deliver sub-standard results.
Another reason is that they are able to implement
specialized features for their own systems such as
accurate lens corrections, noise suppression algorithms, highlight recovery and a range of other
sensor and camera specific solutions that other
providers haven’t done.
Adobe Lightroom is able to read and process most
of the files from Hasselblad, Phase One and MamiyaLeaf cameras but it is not currently capable

of establishing a tethered connection. The only
medium format camera supported for tethered
capture in Adobe Lightroom is the Leica S. It’s
worth noting that Leica does not supply its own
RAW processing software with the camera, but
does provide capture software called Image Shuttle that offers greater camera controls. Should
you prefer to use Adobe Lightroom as your processing software for any of the other medium format cameras, it is possible to shoot tethered using
the manufacturer’s proprietary capture software
and set up a Watched Folder structure that allows
Adobe Lightroom to pull the images from there.

WORKING WITH HASSELBLAD AND PHOCUS
The Hasselblad H-system uses the Firewire 800
9-pin standard to connect to a computer running
Hasselbad Phocus software. The Hasselblad system offers two different file formats. A lossless
compressed RAW format called 3FR used when
shooting to CF card and another format called 3F
for importing or shooting tethered. The 3F file
offers the advantage of embedding all of the information in regards to previews, metadata, lens
corrections, adjustments, etc., into the file so you
can move 3F files onto another machine running
Phocus and maintain all of the adjustments made
to these files.
As mentioned in Chapter 6, Phocus is a capture
and RAW processing software dedicated to supporting files off the Hasselblad digital H-system
cameras. When tethering, Phocus gives you full
control of the camera’s functions and programming options. You can even specify detailed user
presets directly from the software and then store
them in the camera.
Advanced controls such as Live Video with overlay – for lining up the shot – and focus adjustment
makes this a powerful tool for the tethered shooter.

For photographers requiring precision multi-shot
capability to achieve extra-large files with exacting detail, Hasselblad offers a couple of multi-shot
cameras, the Hasselblad 4-shot H5D-50MS and
6-shot H5D-200MS. For those particular camera
models, the Phocus software allows you to choose
between single and multi-shot modes and also
gives you instant feedback if any movement was
detected during capture.

WORKING WITH PHASE ONE OR MAMIYA
LEAF AND CAPTURE ONE
The latest models from both Phase One and Mamiya Leaf, the Phase One IQ series and Leaf Credo,
offer the option to tether using either FireWire
800 or USB 3.0. While the FireWire cable must
connect to a (now less common) FireWire computer port, the USB 3.0 cable has a Male A end
and can connect to either USB 2.0 or 3.0 computer
port, making these digital camera backs more versatile in terms of tethering to connect to modern
computers.

CAPTURE ONE CAMERA INTERFACE
Although Phase One owns both companies, their
digital backs offer different features and functionalities. But, the common ownership shines
through in that both products utilize the same capture and RAW processing software, namely Phase
One Capture One, and offer the same proprietary
file formats: IIQ L, which is an uncompressed 16bit RAW file, and IIQ S, which compresses the
RAW data to provide a smaller file size.
Capture One works by either creating a Session,
keeping all of the relevant files in one single folder structure, or by creating a Catalog (much like
Adobe Lightroom). As noted in Chapter 3, the Session set up is optimal for tethering. Either way,
information about adjustments and previews are

stored in a sidecar file. For those concerned about
the sidecar getting separated from the RAW capture, Capture One gives you the option to export
an “Enhanced Image Package”or EIP file, which
packages the RAW data and associated sidecar
into a single unit. EIP files can only be opened in
Capture One.
When used with the Phase One and XF camera
bodies, for example the new XF camera system,
both the IQ and Credo backs offer full control
of the camera system in relation to settings, exposure control, focus adjustment and Live View,
etc., giving you immense control of the workflow
and shooting conditions.
Hasselblad Phocus and Phase One Capture One
both run on Mac OS and Windows machines. See
Chapter 3 in this guide for detailed instructions on
setting up a tethered session using Capture One.

SECURING A STABLE CONNECTION
Regardless of the medium format digital camera
or back you are using, connecting it to a computer for tethered shooting is relatively simple and
easy. On Mac OS, it is simply “plug and play” and
on Windows machines the installer takes care of
installing the relevant drivers needed for the camera to establish a connection. There are, however,
a number of possible obstacles on your way to a
100% stable connection.

USING FIREWIRE
On newer Macs, where the FireWire port has
been omitted, you will have to use a Thunderbolt to FireWire adapter. If you have any issues
transferring files through your FireWire Adapter,
you may want to use a FireWire800 repeater/hub.
Keep the repeater/hub close to the computer in
the cable connection chain.
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Because of the large file sizes produced by medium format digital cameras, cable quality is crucial. Invest in the highest quality cables that are
fully shielded to protect against external interference and transmission errors. Make sure your
FireWire cables comply with IEEE 1394b specifications, which will make them backwards compatible with existing FireWire technology.

Due to the size of files produced by medium format digital backs and cameras, the maximum recommended cable length for FireWire 800 is 15ft
(4.6m). Extending cables beyond 15 ft (4.6m) creates a very real risk of data loss. Adding a FireWire 800 Hub or Repeater to the connection can

reduce drops when adding a second FireWire cable to achieve the maximum length of 32 ft.

USING USB 3.0 CABLES
The recommended maximum length for a single
USB 3.0 cable is also 15 ft (4.6m). However, in order to save battery power, computer manufacturers are currently underpowering or dynamically
powering the USB 3.0 ports causing inconsistent
signals and incompatibility during USB 3.0 tethering sessions. With the common challenge of underpowered USB ports on laptops and computers,
you may see connectivity issues even at 15 ft. If you
experience dropped signals at 15 ft. adding a powered signal booster such as the TetherBoost Pro
USB 3.0 Core Controller will help ensure a stable
connection to the computer.
If you need more distance between your camera
and computer, adding a TetherBoost will enable
two 15 ft (4.6m) cables (or one 15 ft base cable plus
four 16 ft (5m) Active Extension cables) to be used
together to achieve a longer stable connection.
For additional details on maximum cable lengths,
cable compatibility and secure cable connections,
see Chapter 5 of this guide.

USB 3.0 tethered connections require a powered booster for long distance performance to ensure signal consistency and reliable image transfer. Optimal set up and power options are show above in this TetherBoost
Pro Core Controller Diagram.
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BACKING UP

W

hen shooting tethered to a computer, you
should do everything possible to make
sure that you have an instant backup of your session as it progresses - just in case your hard drive
decides to die on you right in the middle of it all.
“That never happens to me” you might think...
Well, it just might, and it’s always better to be
safe than sorry.
Regardless of what camera or software you may
be using or if you are shooting on location or in
studio, the principle is the same - Shoot directly
to your local hard drive and concurrently copy
the content to an external drive. Whether that
drive is a second drive connected to the computer
or a network drive on your local network does
not make much difference in the way the backup
process is set up. However shooting directly to a
local network drive is not recommended. If the
network performance is not 100% consistent, it
could lead to potential image corruption or loss.
Although some capture software solutions may
provide an additional backup option, for the purposes of this article, we will be focusing on the
process of backing up to a hard drive using an independent and dedicated stand-alone solution.
Using a dedicated software application for our
backup ensures that there is no interference with
the capture software of any kind and that we are
actually using an application which is designed to
do exactly this - back up our data.

Choose a fast hard drive or SSD drive with a USB
3.0 interface if available. With continuous backup it is essential that the data is delivered as fast
as possible so it won´t slow down the rest of the
system.
There are many backup software solutions to
choose from.” Or if you want it chattier “When
it comes to backup software solutions, you have
a large selection to choose from.Some solutions
offer “on the fly” backup of your files – which
means your files will be backed up immediately
as you shoot. Others offer a regularly scheduled
or occasional backup - which are activated as you
have a break in the shooting. What you choose is
not so important as long as it gets the job done.
Applications such as Goodsync, which have the
ability to sync in real-time are ideal for this job.
There are plenty of options for both Mac and
Windows to choose from but Goodsync is actually available for both platforms. It is very easy to
set up and once activated you can concentrate on
your photography with ease of mind.

NOTE:
Both Mac and Windows machines have built-in backup features but controls are limited for what we are
trying to do here. Time Machine (Mac) and Windows
Recovery are incremental backup solutions, and not
suited for backing up tethered capture sessions.
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If you are working with the recommended naming structure for your capture folder (date, client,
job, etc.) you will need to set that up in the backup software prior to each shoot, so that it knows
where to copy the data from. This is an easy task
and only takes a few seconds. Another option is to
always use the same capture folder and then copy
over the captures to the workstation or proper
location after the shoot finishes. This approach
gives you a “one-click” solution for every session.
We will use this model for the step-by-step process outlined here.

A STEP-BY-STEP GUIDE TO SETTING UP AN
AUTOMATED BACK UP SYSTEM
Before setting up the backup software, make sure
that your hard drive is connected to your computer with the proper cable. We are showing how to
do this using GoodSync but there are other backup options available as well.

The Analyze function in the software makes sure
only new files are added to the backup folder.

2. In the main window choose the source
folder (Capture Folder) and destination
folder on your external drive (we have
named the folder “Session backup”)

Although we are specifically describing Goodsync
in this article, the workflow outlined here would
generally apply to all other backup solutions supporting real time sync as well.

SETTING UP YOUR BACK UP DRIVE

3. In the General pane make sure “Propagate
Deletions” is unchecked. This will ensure
that if you accidentally delete files from
the backup drive they won´t also be deleted in your capture folder.

1. Launch Goodsync and create a new job
and name it “Tethered Session”. Make sure
to select the Backup option as we are only
interested in a one-way synchronization.

Using the Tether Tools Aero Table with an Aero
XDC (eXternal Drive Compartment) is ideal for
this type of backup workflow as the external drive
resides in its own compartment under the table
and out of the way. Securing the cable connection
from computer to hard drive can also help prevent
unwanted disconnects during the capture session.
6. Launch your preferred tethering software
and make sure your capture folder is identical to the source folder you selected in
the backup software.
Now, when you start capturing your images to
the computer, all files will be simultaneously copied over to your backup drive as they come in.
Please note that this may have an impact on performance depending on the drive’s speed, the size
of the files and how quickly you’re shooting. This
is why some prefer to do incremental backup between series of captures.

USING MANUAL BACKUPS INSTEAD OF AUTOMATED
4. In the Auto pane check “Analyze” and
“Sync” to enable real time synchronization
of your files. Leave all other options, except “Wait for Locks to clear” unchecked
as shown below.
5. Click OK.

If you prefer to do a manual incremental backup
instead, simply leave out step 4 from above, then
whenever you have a break in the shoot check
the “Analyze” box followed by the “Sync” box as
shown in the illustration for Step 5 and then click
“OK”. This will initiate a backup of your files between your capture folder and your backup folder. You can repeat this action as often as you like.

Storing and archiving your files are a critical part
of a complete tethering workflow and there are
many great resources for ensuring your files and
business assets are optimally managed and secure.
Below are additional links you may find helpful:
• Backing Up, dpBestFlow.org
• Hard Drive Enclosures, dpBestFlow.org
• Setting up GTech Drives, by GTech
• Caring for Drives, dpBestFlow.org
• Setting Up an Adhoc Network, Gary Mar-

